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序文 
 
本マニュアルについて 
 
このマニュアルは、FEMtools 3.5 における新しい機能、機能強化、および訂正について記述したものです。 
 
FEMtoolsマニュアルにおいて使用される規則 
 
FEMtools マニュアルは、視覚的に情報を識別するのに便利なように、いくつかの規則を設けています。 
 

タイプのスタイルまたは記号         用途                    
extract nodes FEMtools コマンドラインの例 
SET ECHO FEMtools コマンドまたはコマンドの構文 
Settings メニューコマンド 

 
統一性と UNIX プラットフォームでの大文字／小文字の区別を考慮して、FEMtools コマンドスクリプトにお

けるすべてのコマンドと引数（特にファイル名）に対して小文字が使用されています。しかし、FEMtools の
ドキュメンテーションでは、読み易くするためにコマンドは通常大文字で記されています。 
 
関係のあるドキュメンテーション 
 
本マニュアルは、次のマニュアルと一緒に用いるのがよいでしょう。 
 
 FEMtools 入門マニュアル 
 
ドキュメンテーションの使用について 
 
FEMtools ドキュメンテーションは、HTML ベースのヘルプとして、および PDF フォーマットでのオンライン

マニュアルとして利用できます。 
 
ヘルプにアクセスするには、Help メニューから Help Topics を選びます。 
 
 全マニュアルの目次の完全なリストを見たい場合は、Contents タブを使います。 
 すべてのインデックスエントリのリストを見たい場合は、Index タブを使います。 
 
その他のタブは、使用するオペレーティングシステムに依存して利用することができます。 
マニュアルにアクセスするには、Help メニューから Manuals を選んでください。PDF ファイルを読むには、

Adobe Acrobat Reader がシステムにインストールされなければなりません。 
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FEMtools 3.5の紹介 
 
FEMtools3.5 は、プリテスト解析、相関分析、モデルアップデーティング、最適化などの主な解析機能が拡張

されました。また、新たなアドンオン・オプションとして、モーダル・パラメータ・エクストラクター（MPE）
実験モーダル解析が統合されました。本バージョンのそれぞれの主なハイライトを次に示します。 
 
インストールとライセンス 
 
FEMtools 3.5 は、Mac OS X 10.5+のサポートが追加されました。 
 
ユーザー・インターフェイス 
 
新たなウィンドウ、ドック化ダイアログボックス、パネルなどのコントロールが導入されました。 
 
スクリプト関数の拡張 
 
コマンド・スクリプト内では、21 の新しいコマンドが追加されました。プログラマは、新しい FEMtools ス

クリプト関数や FEMtools API 関数を使用することが可能となります。 
 
FEデータ・インターフェイスの更新 
 
ユーザーの要望に基づいて、FE プログラム・インターフェイスおよびドライバの多くが拡張されました。最

新の NASTRAN および ANSYS のインターフェイス・プログラムは、MSC.Nastran 2010、最新の ANSYS 13
をサポートするために更新されました。 
 
対話式プリテスト解析 
 
テスト用トランスデューサの配置するための DOF の選択、また直接 MAC マトリックスに対する影響を評価

するための新しいツールが組み込まれました。これらの DOF は、FE モデル上で追加や削除ができます。 
 
モーダル・パラメータ・エクストラクター・アドオン 
 
新しいモーダル・パラメータ・エクストラクター（MPE）アドオン・モジュールは、周波数応答関数（FRF）
やクロスパワー・スペクトルからモーダル・パラメータを抽出するためのツールです。 
 
相関分析 
 
シェープ相関基準は、座標系、DOF セット、シェープ・セットのための一貫したセッティングを使用します。 
 
ODSベースのモデルアップデーティング 
 
ODS ベースのモデルアップデーティングに使用される相関性基準は、変位位相相関（DPC）を含みます。こ

の基準は、2 つのシェープ間の全位相差を示します。 
 
不連続（離散）材料の最適化（DMO） 
 
不連続材料の最適化（DMO：Discrete material optimization）が複合材料などの最適化ツールとして追加されま

した。DMO は許容範囲内の材料や方位角のセットに基づく最適な材料、方位角を識別することができます。 
 
遺伝的アルゴリズム（Genetic Algorithm）による最適化 
 
遺伝的アルゴリズムは確率的な最適化方法です。自然淘汰や遺伝的な概念を使用し、反復的に最適化ソリュ

ーションを探索します。 
 
不連続（離散）トポメトリー最適化 
 
トポメトリーの最適化は、最適化パラメータとして、不連続プレート厚の値をサポートします。 
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FEMtools 3.5ドキュメントとトレーニング 
 
FEMtools 3.5 ドキュメントは、オンライン・ヘルプ、コース（セミナー）ノート、電子ブック（PDF）、マニ

ュアル印刷媒体などから成ります。従来リリースされているドキュメントは、すべての変更を反映するため

に更新されました。新たに高度なユーザーのためにコース情報が提供されます。 
 

 
 

ドキュメント概要 
 
FEMtools 3.5 ドキュメントは次のドキュメントで構成されます。 
 
 FEMtools 3.5 Release Notes（リリース・ノート）- このマニュアルは、FEMtools 3.5 の新しい特徴を紹介

し、既存バージョンからアップグレード方法についても記述します。 
 
 FEMtools 3.5 Getting Started Manual（スタート・マニュアル）- このマニュアルは、インストール、ラ

イセンス管理、FEMtools の起動や環境設定について説明します。 
 
 FEMtools 3.5 Framework User's Guide（フレームワーク・ユーザーガイド）- このガイドは、FEMtools

モジュール（ユーザー・インターフェイス、データベース、データ・インターフェイス、スクリプト言

語、グラフィックス）の情報について記述します。 
 
 FEMtools 3.5 Mesh User's Guide（メッシュ・ユーザーガイド）- このガイドは、メッシュ生成、メッシ

ュ変形、要素変換、メッシュ精度に関連するメッシュ・ツールについての情報を記述します。 
 
 FEMtools 3.5 Dynamics User's Guid（ダイナミクス・ユーザーガイド）- このガイドは、FEMtools を使

用た構造ダイナミクス・シミュレーションの理論的背景、例証および実例などを記述します。 
 
 FEMtools 3.5 Correlation User's Guide 相（関分析ユーザーガイド）- このガイドは、相関分析およびプ

リテスト解析の理論的背景、例証および実例などを記述します。 
 
 FEMtools 3.5 Model Updating User's Guide（モデルアップデーティング・ユーザーガイド）- このガイ

ドは、感度解析を使用した、モデルアップデーティング、外力同定、および確率論的解析などの例証お

よび実例などを記述します。 
 
 FEMtools 3.5 Model Updating Theoretical Manual（モデルアップデーティング理論マニュアル）‐ この

マニュアルは、FEMtools モデルアップデーティングでインプリメントされた差分解析法やツールの理論

的背景を記述します。 
 
 FEMtools 3.5 Model Updating Examples Manual（モデルアップデーティング例題マニュアル）- このマ

ニュアルは、相関分析、モデルアップデーティングなどに関する多彩なモデルの例題を集録しています。 
 
 FEMtools 3.5 Optimization User's Guide（最適化ユーザーガイド）- このガイドは、最適化の理論的背景、

例証、実例および一般非線形プログラミング、DOE/RSM、サイズ、形状、トポロジー、トポメトリーの

最適化を使用した例題を記述します。 
 
 FEMtools 3.5 Modal Parameter Extractor User’s Guide（モーダル・パラメータ・エクストラクター・ユ

ーザーガイド）- このガイドは、モーダル・パラメータの抽出に関する理論的背景、実例および周波数

応答関数（FRF）からのモーダル・パラメータを抽出方法の例題を記述します。 
 
 FEMtools 3.5 Rigid Body Properties Extractor User’s Guide（剛体特性エクストラクター・ユーザーガイ

ド）‐、剛体特性エクストラクターの理論的背景、周波数応答関数（FRF）からの剛体特性を抽出する

実例などを記述します。 
 
 FEMtools 3.5 ABAQUS Interface User's Guide（ABAQUS インターフェイス・ユーザーガイド）- このガ

イドは、FEMtools による ABAQUS データのインポートおよびエクスポートの方法を記述します。 
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 FEMtools 3.5 ANSYS Interface User's Guide（ANSYS インターフェイス・ユーザーガイド）- このガイ

ドは、FEMtools による ANSYS データのインポートおよびエクスポートの方法を記述します。 
 
 FEMtools 3.5 NASTRAN Interface User's Guide（NASTRAN インターフェイス・ユーザーガイド）- こ

のガイドは、FEMtools による NASTRAN データのインポートおよびエクスポートの方法を記述します。 
 
 FEMtools 3.5 UNIVERSAL FILE Interface User's Guide（UNIVERSAL FILE インターフェイス・ユーザ

ーガイド）- このガイドは、FEMtools によるユニバーサル・ファイル・フォーマット・データ（解析と

テスト）のインポートおよびエクスポートの方法を記述します。 
 
 FEMtools 3.5 Programmer’s Guide（プログラム・ガイド）- このマニュアルは、アプリケーション・プ

ログラム例、FEMtools スクリプト・リファレンスおよび API リファレンスを記述します。 
 
 FEMtools 3.5 GUI Reference（GUI リファレンス）- これは、メニュー、ツールバー、ダイアログボッ

クスについての情報を記述したリファレンス・マニュアルです。 
 
 FEMtools 3.5 Command Reference（コマンド・リファレンス）- これは、FEMtools コマンド言語要素に

ついての情報、およびシンタックス、引き数および例を含む各コマンドについての詳細な情報を含んで

いる電子リファレンス・マニュアルです。同様のオンライン・バージョンはソフトウェアに含まれてい

ます。 
 
 FEMtools 3.5 Scripting Reference（スクリプト・リファレンス）- これは、FEMtools スクリプト言語要素

（変数、演算子、関数、ステートメント）について記述した電子リファレンス・マニュアルです。完全

なオンライン・バージョンはソフトウェアにも含まれています。 
 
 FEMtools 3.5 Application Programming Interface （API） Reference（アプリケーション・プログラム・

インターフェイス（API）リファレンス）- これは、FEMtools データベースを操作するための関数や方

法を説明した電子リファレンス・マニュアルです。同様の完全なオンライン・バージョンはソフトウェ

アにも含まれています。 
 

ドキュメント名 フォーマット 

FEMtools 3.5 Getting Started Manual  PDF, Help 

FEMtools 3.5 Release Notes  PDF 

   

FEMtools 3.5 Framework Userʹs Guide  PDF, Help 

FEMtools 3.5 Mesh Userʹs Guide  PDF, Help 

FEMtools 3.5 Dynamics User’s Guide  PDF, Help 

FEMtools 3.5 Correlation User’s Guide  PDF, Help 

FEMtools 3.5 Model Updating User’s Guide  PDF, Help 

FEMtools 3.5 Model Updating Theoretical Manual  PDF 

FEMtools 3.5 Model Updating Examples Manual  PDF 

FEMtools 3.5 Optimization User’s Guide  PDF, Help 

   

FEMtools 3.5 Modal Parameter Extractor User’s Guide  PDF, Help 

FEMtools 3.5 Rigid Body Properties Extractor User’s Guide  PDF, Help 

   

FEMtools 3.5 ABAQUS Interface User’s Guide  PDF, Help 

FEMtools 3.5 ANSYS Interface User’s Guide  PDF, Help 

FEMtools 3.5 NASTRAN Interface User’s Guide  PDF, Help 
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 FEMtools 3.5 UNIVERSAL FILE Interface User’s Guide  PDF, Help 

   

FEMtools 3.5 Programmer’s Guide  PDF 

   

FEMtools 3.5 GUI Reference Manual  Help 

FEMtools 3.5 Command Reference Manual  Help 

FEMtools 3.5 Scripting Reference Manual  Help 

FEMtools 3.5 API Reference Manual  Help 

 
Help は、FEMtools ヘルプ・メニューからアクセス可能なオンライン・ヘルプを参照します。ヘルプには、

Microsoft HTML（Windows）と HTLM（unix/Linux）のタイプがあります。 
 
PDF は、アドビ・アクロバット・ポータブル・フォーマット（PDF）を参照します。これらのファイルは、

アドビ・リーダ・ソフトウェアを使用して読むことができます。その Windows 用と Unix/Linux 用のフリーの

ユーティリィティはアドビ・システムズ（www.adobe.com）からダウンロードし、利用することができます。

アドビ・アクロバットの PDF フォーマット・マニュアルは印刷することができます。オンライン・マニュア

ルにアクセスするには、Help メニューから Manuals を選んでください。 
 

 
 

ドキュメントと例題の変更について 
 
ドキュメントと例証ディレクトリの主な追加/変更点を次に示します。 
 
 新規の FEMtools 3.5 Modal Parameter Extractor User’s Guid（モーダル・パラメータ・エクストラクタ

ー・ユーザーガイド） 
 FEMtools 3.5 Optimization User's Guide（最適化ユーザーガイド）中のローカル材料特性の最適化および

遺伝的最適化に関する新しい章 
 モーダル・パラメータ・エクストラクター用の例題サブディレクトリ（...¥examples¥mpextractor）が追加

されました。例題は、www.femtools.com サイトの

http://www.femtools.com/download/ft_mpe_examples_350.fti からダウンロードすることができます。パッケ

ージ・ディレクトリ（<installdir>¥3.5.0¥packages）にこのパッケージをダウンロードし、保存してくださ

い。それは、Add-on（アドオン・メニュー）からインストールすることができます。 
 ローカル材料特性最適化用の例題サブディレクトリ（...examples¥dmo）が追加されました。 
 遺伝的アルゴリズム用の例題サブディレクトリ（...examples¥genetic）が追加されました。 
 

 
 

FEMtoolsトレーニング・コース 
 
DDS とそのパートナーは、上級ユーザーおよび FEMtools アプリケーション開発者のためのセミナー・コー

スをはじめ、新規ユーザーなどの初心者コースも用意されています。 
 
より詳細については、 support@femtools.comに連絡するか、http://www.femtools.com/coursesから、それらの最

新情報を閲覧してください。 
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FEMtools 3.5の更新点の概要 
 

 
 

インストール、ライセンス、構成 
 
サポート・オペレーティング・システムおよびインストールに必要な条件については後述します。 
 
FEMtools 3.5 サポート･プラットフォーム 
 
次のテーブルは、FEMtools 3.5 に支援されたプラットフォームの概観を示します。 
 

プラットフォーム  オペレーティング・システム  プロセッサー 

WIN32  Windows XP, Vista 32‐bit, Windows 

7 32‐bit   

Intel x86; AMD 32 

WIN64  Windows XP Pro 64‐bit, Vista 64‐bit, 

Windows 7 64‐bit   

Intel EMT64; AMD 64   

LIN32  Red Hat, SUSE 32‐bit,…  Intel x86; AMD 32 

LIN64  Red Hat, SUSE 64‐bit,…  Intel EMT64; AMD 64   

MAC64  Mac OS X 10.5 or higher  Intel x86 

HP64  HP‐UX 11.00 or higher  HP 64‐bit PA‐RISC1 

SOL64  Solaris 2.8 or higher  Sun SPARC 64‐bit 

AIX64  AIX 5.1 or higher  PowerPC 64‐bit 
1 PA-RISC 1 2.0（LP64）："+DA2.0W"指定でコンパイルされたアプリケーション 
プラットフォームのサポートに関する最新情報は、FEMtoolsウェブサイト（http://www.femtools.com）

を確認してください。 
 
インストール条件 
 
Widows 
 
 Microsoft Windows XP、Microsoft Vista、MicrosoftXP Pro 64 ビット、MicrosoftVista 64 ビット（Windows7 

32/64 ビット） 
 メモリ：1 GB RAM 以上 
 ハードディスク・スペース：250MB 以上の空き 
 OpenGL をサポートするグラフィックスカード 
 OpenGL の高速化をサポートするグラフィックスカードによってグラフィックスの性能は向上します。 
 CD や電子メールからインストールするための CD-ROM ドライブ、インターネット接続 
 USB ポート（ノードロック・ライセンス・オプション用） 
 ライセンスサーバー（フローティング・ライセンス・オプション用）の TCP/IP 接続 
 Adobe Acrobat Reader あるいは類似のソフトウェア（PDF オンライン・ドキュメントを読むため） 
 
Linux 
 
 Red Hat Linux 9.0+（SUSE 9.0+）、Linux 32/64 ビットをサポートします。 
 メモリ：1 GB RAM 以上 
 ハードディスク・スペース：250MB 以上の空き 
 OpenGL をサポートするグラフィックスカード 
 OpenGL の高速化をサポートするグラフィックスカードによってグラフィックスの性能は向上します。 
 CD や電子メールからインストールするための CD-ROM ドライブ、インターネット接続 
 USB ポート（ノードロック・ライセンス・オプション用） 
 ライセンスサーバー（フローティング・ライセンス・オプション用）の TCP/IP 接続 
 Adobe Acrobat Reader あるいは類似のソフトウェア（PDF オンライン・ドキュメントを読むため） 

 5



 
Mac OS X 
 
 x86 プロセッサーの Mac OS X 10.5+ 
 メモリ：1 GB RAM 以上 
 ハードディスク・スペース：250MB 以上の空き 
 OpenGL をサポートするグラフィックスカード 
 OpenGL の高速化をサポートするグラフィックスカードによってグラフィックスの性能は向上します。 
 CD や電子メールからインストールするための CD-ROM ドライブ、インターネット接続 
 USB ポート（ノードロック・ライセンス・オプション用） 
 ライセンスサーバー（フローティング・ライセンス・オプション用）の TCP/IP 接続 
 Adobe Acrobat Reader あるいは類似のソフトウェア（PDF オンライン・ドキュメントを読むため） 
 
Unix 
 
Unix コンピューターとオペレーティング・システムごとに、FEMtools のユニークなバージョンがあります。 
インストール・バージョンがそれぞれのシステムをサポートしていることを確認しなければなりません。 
 
その主な必要条件は次のとおりです。 
 
 メモリ：1 GB RAM 以上 
 ハードディスク・スペース：250MB 以上の空き 
 OpenGL をサポートするグラフィックスカード 
 OpenGL の高速化をサポートするグラフィックスカードによってグラフィックスの性能は向上します。 
 CD や電子メールからインストールするための CD-ROM ドライブ、インターネット接続 
 ライセンスサーバー（フローティング・ライセンス・オプション用）の TCP/IP 接続 
 Adobe Acrobat Reader あるいは類似のソフトウェア（PDF オンライン・ドキュメントを読むため） 
 
インストールの変更点 
 
FEMtools 3.5 は、Mac OS X のサポートが追加されました。 
 
最新バージョンでは、パッチをインストールするためのアドオン・インストーラを使用することができます。

パッチは、パッチと同一バージョン番号の FEMtools にインストールすることができます。 
 
Windows 
 
デフォルトでは、FEMtools 3.5 はディレクトリ C:¥FEMtools¥3.5（Windows）にインストールされます。イン

ストール・ディレクトリはインストール中に変更することができます。インストール・パスはブランクを含

せることも可能です。 ま

 

Windows において、“Program Files”ディレクトリにインストールする場合には、デフォルト FEMtools イン

ストールが例題や編集用スクリプトを含むために「容認」も応答指示を必要とする問題を引き起こすかも

しれません。したがって、ユーザーは書き込み許可を備えたフォルダにユーザーによって編集可能なファ

イル（スクリプト、例題、スタイル、xml、...）によって編集可能な FEMtools ディレクトリにインストー

ルすることを推奨します。 

 
Mac OS 
 
Mac OS X のためのインストール・パッケージは DMG ファイル（ディスク・イメージ）として運用されます。

これには、FEMtools システム・ファイル、例題、インストール・パッケージを含まれます。システム・ファ

イルはアプリケーション・フォルダにインストールすることができます。例題フォルダは、書き込み許可に

よって、すべてのユーザーからアクセスが可能でなければなりません。Mac システムでは、任意の場所にイ

ストールすることができます。 
 
ン
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ライセンス 
 
FEMtools 3.5 はライセンス管理のために RLM 8.0 を使用します。より詳細な情報に関しては、RLM ドキュメ

ントを参照してください。 
 
インストール・パッケージは、Safenet 社の Superpro ドライバ（Windows 用 v7.6.1、Linux と Mac OS X 用 v7.4.0）
を含みます。 
 
アドオン・ライセンスが利用可能な場合、そのアドオンがまだインストールされてないことが検知され、ア

ドオンのインストール・スタートアップが起動します。 
 
構成変更 
 
初めて、新しい FEMtools を実行した場合、FEMtools スタートアップは、旧バージョンのセッティング・フ

ァイルをチェックし、既存のカスタマイズされたセッティングを再度使用するかユーザーに尋ねます。 
 
FEMtools旧バージョンからアップグレード 
 
以下は、FEMtools 1.x、FEMtools 2.x、FEMtools 3.0.x、FEMtools 3.1.x、FEMtools 3.2.x、FEMtools 3.3.x あるい

は FEMtools 3.4.x から FEMtools 3.5 にアップグレードするユーザーのための重要な情報です。 
 
 新しいディレクトリ（デフォルトでは、C:¥FEMtools¥3.5）に FEMtools 3.5.0 をインストールすることを

推奨します。 
 
 初めて、このバージョンをスタートする場合、新しいセッティング・ファイルがホームディレクトリ中

に作成されます。以前のインストールのセッティング・ファイル中で行なった修正をスタートアップ上

の新しいセッティング・ファイルに自動的にコピーすることができます。 
 
 旧バージョンで使用されたドライバ・スクリプトのドライバ・セッティングおよびカスタマイズ設定は、

FEMtools 3.5 用に自動的に適用されません。それらのドライバに対するカスタマイズは、FEMtools 3.5
バージョンの INI ファイルや BAS ドライバ・スクリプトにおいて、同様のカスタマイズをしなければな

りません。それらのファイルは、<installdir>¥scripts¥drivers に存在します。 
 
 FEMtools 3.5 のノードロックおよびフローティング・ライセンス・キーは、FEMtools 3.4.x バージョン用

のライセンス・キーと互換性をもちます。それらのユーザーは新しいライセンス・ファイルを必要とし

ません。初期バージョン（v3.3.x およびそれ以前）からアップグレードするユーザーは、新しいライセ

ンス・ファイルが必要です。 
 
 ヘルプのコマンド・リファレンスの各章および FEMtools 3.5 リリース・ノートにおいて、FEMtools コマ

ンド言語の変更点を確認し、必要に応じて、既存のコマンド・スクリプトを更新してください。 
 
 ヘルプの API リファレンスおよび FEMtools 3.5 の FEMtools API への変更点を確認し、必要に応じて既存

のプログラム・スクリプトを更新してください。 
 
 FEMtools 3.x プロジェクト・ファイルは、FEMtools 3.5 にインポートすることができます。 
 

 
 

データ・インターフェイスとドライバ・プログラム 
 
データ・インターフェイス・プログラムの変更点の概要を以下に示します。 
 
ABAQUSインターフェイスとドライバ 
 
 nastran.ini ドライバ構成ファイルへの新しい接続エントリーの追加 

使用可能コマンド：rsh, putty, ssh2 
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ANSYSインターフェイスとドライバ 
 
 インターフェイス・プログラムは、ANSYS 13.0 バイナリー・ファイルをサポートします。 
 
 BEAM188 要素は、BEAM44 要素に取って代わり、この BEAM188 は、Timoschenko の二次の公式化を使

用します。また、BEAM4/44 は「オイラー=ベルヌーイ」の公式を使用します。それらのビーム要素の結

果には、いくつかの違いが生じることに注意してください。ANSYS は要素中間に生成された新しいノー

ドを使用し、オリジナルの BEAM188（KEYOP(3)=2： 二次元）要素マトリックスを計算します。EMAT
ファイル中の要素マトリックスをエクスポートし、FEMtools 中にこれらの要素マトリックスをインポー

トする場合、この余分なノードが問題を引き起こします。非互換性のメッセージを表示し、その追加ノ

ードのモードシェープ値はインポートされません。 
 
 要素タイプ MATRIX27 をサポートし、このマトリックスがバネ剛性に相当する場合、FEMtools によっ

て認識され、6 つの DOF スプリング要素としてインポートされます。また、それは、MATRIX27 として

エクスポートされませんが、COMBIN14 のセットとしてエクスポートされます。 
 
 要素タイプ MATRIX50（スーパー要素）は、ANSYS.DMP ファイルに格納され、対応する要素タイプと

id は、ANSYS へのエクスポートする際に、再番号付けされます。 
 
 MPC184（剛体リンクあるいは剛体ビーム）は、RBAR としてインポートされ、MPC184 としてエクスポ

ートされます。 
 
 要素タイプ 285（四面体ソリッド）のサポート：この要素タイプは変位と流体静力学の自由度を組み合

わせます。インターフェイスは、この要素タイプを保存し、外部ソルバーとして ANSYS の使用を許可

します。 
 
NASTRANインターフェイスとドライバ 
 
 インターフェイス・プログラムは、MSC.Nastran 2010 をサポートします。 
 
 NASTRAN を実行する場合、NASTRAN ドライバは、再使用するためにダンプ・ファイル（nastran.dmp）

から、ASSIGN ステートメント（ファイル管理）を取って来ます。 
 
 非線形要素の要素応力は、OES1 データ・ブロックを使用し、OP2 ファイルからインポートすることが

できます。詳細については、Ft_ReadOP2Shape を参照してください。 
 
 nastran.dmp ファイル中のデータ・カードを再配置する新しいメカニズムが追加されます。この目的のた

めに、NASTRAN 入力ファイルに置かれる特別のコメント・カードが使用されます。 
 

$FT_SKIP_ON このマークはトランスレータによってスキップされ、nastran.dmp ファイ

ルにコピーされるセクションの始まりを示します。 
$FT_SKIP_OFF  このマークはトランスレータによってスキップされたセクションの終了

を示します。 
 
追加された特別のコメント・カードは特定の予備的処理の目的のために使用することができます。 
 

$FT_USE_HEADER$filena
me 

このマークは、指定ファイルのヘッダーによって、「nastran.tmp」ファイ

ル中の BEGIN BULK ステートメント上のすべての情報を交換します。 
$FT_REPLACE$searchtext
$replacepattern 

このマークは、「nastran.tmp」ファイル中を searchtext によって定義され

たストリングから始まるラインを走査します。残りのラインは次の方法で

置換パターンと取り替えられます。 
 
 置換パターンが@の場合、ライン中の元の文字が維持されます。 
 置換パターンが@と等しくない場合、ライン中の文字は置換パター

ンと取り替えられます。 
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 NASTRAN マトリックスの代わりに FEMtools 要素マトリックスを内部計算するために使用する新しい

セッティングセットの SET TUNE SENSITIVITY INTERNAL をサポートします。このセッティングは、

非常に大規模な有限要素モデルの場合に障害となるOP2からNASTRAN要素マトリックスをインポート

する必要性を回避するために使用されます。 
 
 NASTRAN ソルバーの実行の直前に、FE モデルを回復し、バックアップするための新しいセッティング

セットの SET TUNE LARGEMODEL をサポートします。このセッティングは、非常に大規模な有限要

素モデルの場合にはメモリ必要容量を縮小するために使用されます。 
 
ユニバーサル・ファイル・テスト・データ・インターフェイスとドライバ 
 
 データセット 2416 のトレースラインのインポート処理が改訂されました。 
 
 データセット 2414 の節点データのインポート処理をサポートします。 
 
 モーダル・テスト・ソフトウェアにおいて、自動的に変数が「interface.uff.flags」=1 と自動的に設定され、

それが検知された場合、不完全な座標系や番号に変換されます。インターフェイス・プログラムは、こ

の場合の変換マトリクスを調整します。 
 

 
 

データベースの管理 
 
この章では、FEMtools 3.5 のデータベース管理の変更点について記述します。 
 
FRF オペレーション 
 
新しい FRF オペレーションとして、周波数レンジの再定義、加振と応答の DOF 交換、再サンプリング、タ

イプ変更などを行なうことができます。 
 
FRF 周波数バンドの下限/上限を修正するには、Database > FRFs > Trim メニューを使用します。 
 
加振と応答の DOF を交換するには、Database > FRFs > Swap メニューを使用します。 
 
コンソールあるいはコマンド・スクリプトからは、MODIFY FRF コマンドを使用します。 
 

 
 

Trim FRF ダイアログボックス 
 

 
 

Swap FRF ダイアログボックス 
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レスポンス（応答）定義 
 
Create Responses ダイアログボックスは再構成され、Typeと Propertiesタブを備えたダイアログボックスです。 
 
Type タグは、利用可能なレスポンス・タイプのリストを示します。このリストは、FEMtools データベースの

データに依存し、モーダル・レスポンス（modal responses）、質量レスポンス（mass responses）、FRF レス

ポンスなどがあります。 
 
Properties タブでは、選択レスポンス・タイプに対応した追加のセッティングが表示されます。 
 

  
 

Create Responses ダイアログボックス（左：Type、右：モード応答の Properties） 
 
シェープのベリフィケーション（検証） 
 
AutoMAC、AutoDAC、AutoEVO、AutoPOC を備えたシェープのベリフィケーションは再構成され、より一貫

性が維持され、同一の基準が FE モードとテスト・モードに適用されます。 
 
次のような選択が可能です。 
 
 座標系 
 解析で使用される DOF 
 解析使用されるシェープ（モードシェープ、オペレーションシェープ） 
 追加のセッティングが選択された基準に関係付けられます。 
 
メニューから、Database > Verify を使用するか、コマンドの EXAMINE MAC、EXAMINE DAC、 EXAMINE 
EVO または、EXAMINE POC を使用します。 
 

 
 

新しい AutoDAC FEA 変位ダイアログボックス 
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新しい AutoPOC FEA モード・ダイアログボックス 
 
ノイズの生成 
 
特別な研究のためには、データ上のノイズをシミュレートすることが必要です。従来、「NOISE」コマンド

が使用されていましたが、再構成されたダイアログボックスが利用可能になりました。 
 
メニューから、Database > Advanced > Add Noise を使用するか、コマンドの NOISE を使用します。 
 

 
 

Generate Noise ダイアログボックス 
 

 
 

メッシュ・ツール 
 
正規表面の押し出しによるメッシュ生成が可能となりました。詳細については、ヘルプ・ドキュメント

（FEMtools API Reference）の Ft_ExtrudeMesh を参照してください。この例題は、例題フォルダ

（../mesh/generation/extrude）に追加され、またメッシュ・ユーザーガイド中でもドキュメント化されています。 
 
DEFINE VERTEX、DEFINE CURVE、DEFINE SURFACE コマンドは、再構成され、処理が高速化されま

した。 
 

 
 

解析 
 
解析モジュールの最も重要な変更点を以下に示します。 
 
マニュアル・プリテスト解析 
 
マニュアル・プリテスト解析用の新しいダイアログボックスが利用可能になりました。これは、手動でセン

サー配置 DOF を選択し、直ちに AutoMAC マトリックスを観察するために使用されるドック化ダイアログボ

ックスです。DOF は、FE モデル上のノードを選択することにより対話式に追加や削除ができます。 
 
選択を終えた後、その DOF セットは他の解析のために再使用することができます。また、トレースラインは
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テスト・モデルを完成するために対話式に付け加えることができます。 
 
マニュアル・プリテスト解析ダイアログボックスをオープンするには、メニューから、Pretest Analysis > 
Manual Pretest Analysis を使用します。 
 
または、コンソールから、PRETEST コマンドを使用してください。 
 
より詳細については、manual pretest ダイアログボックス上のヘルプ（Help ボタン）から、あるいは、PRETEST
コマンドのヘルプを参照してください。 
 

 
 

manual pretest ダイアログボックス 
 
相関分析 
 
新しい基準の複素実稼動シェープ間の相関分析機能が追加されました。実稼動位相相関性（DPC:Operational 
Phase Correlation）は、複素シェープ間の位相差を解析し、ODS ベースのモデルアップデーティングに使用す

ることができます。 
 
メニューから、 Correlation Analysis > Operational Phase Correlation (DPC) を使用するか、コマンドの

EXAMINE DPC を使用します。 
 

 
 

Operational Phase Correlation（DPC）ダイアログボックス 
 
POC 分析（擬似モード直交性チェック）のためのコマンドが追加され、次の選択が可能となりました。 
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 参照モデル 
 座標系 
 解析で使用される FE とテストのシェープ 
 システム・マトリックス（質量、剛性） 
 追加されたセッティングは、モードシェープの正規化にも関係します。 
 
メニューから、Correlation Analysis > Pseudo-Orthogonality (POC)を使用するか、コマンドの EXAMINE POC
を使用します。 
 

 
 

Pseudo-Orthogonality (POC)ダイアログボックス 
 
剛体特性エクストラクター（RBPE:Rigid Body Properties Extractor） 
 
RBPE のユーザー・インターフェイスは単一のパネルを使用して再構成されました。パネルを構成するそれ

ぞれのサイズはドラッグ操作により修正することができます。 
 
また、ハードディスク・シャーシの FRF テストデータを使用した例題が追加されました。それ

は、..¥examples¥rbpextractor¥disk..¥examples¥rbpextractor¥disk を参照してください。この例は、RBPE ユーザー

ガイドにもドキュメント化されます。 
 

 
 

Rigid Body Property Extractor パネル 
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モーダル・パラメータ・エクストラクター（Modal Parameter Extractor） 
 
新しいモーダル・パラメータ・エクストラクター（MPE）アドオン・モジュールは、1 セットの周波数応答

関数（FRF）かクロスパワー・スペクトルからモーダル・パラメータを抽出するためのツールです。 
 
このエクストラクターは、対話式のグラフィカルな環境中で統合化され、次のような特徴をもっています。 
 
 ユニバーサル・ファイル・フォーマットの測定 FRF のインポート 
 
 GUI ウィザード、pLSCF モーダル・パラメータ・エクストラクターを使用するモーダル・パラメータの

推定 
 
 安定化ダイグラムに基づいた自動/手動のポール（極値）の選択 
 
 抽出されたモーダル・パラメータによる MPD、MPC、AutoMAC、シンセサイズ FRF、モードシェープ・

アニメーション 
 
 高度なグラフィックス・ビューアー：モードシェープ・アニメーション、シンセサイズ FRF のプロット

など 
 
 スクリプトの使用によるエクストラクターの自動データ処理の統合化 
 

 
安定化ダイアグラム例 

 

 
 

選択ポール（極値）の確認 
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ODSベースのモデルアップデーティング 
 
ODS ベースのモデルアップデーティング・アルゴリズムは、アップデート・レスポンスとして、解析と実験

のシェープ間の相関係数を使用します。相関係数は、選択した実験シェープの周波数ラインと見積もられま

す。 
 
変位位相相関（DPC）は、2 つのシェープ間の全ての位相差を示します。それは、相関係数の計算のために、

ODS ベースのモデルアップデーティングに使用される変位保証基準（DAC）や変位スケール係数（DSP）に

加えて使用されます。 
 
DPCの計算方法については、Correlation Analysis（相関分析）を参照してください。 
 
より詳細については、「FEMtools Model Updating User's Guide」の ODS ベースのモデルアップデーティング

の章を参照してください。あるいは、http://www.femtools.com/products/papers.htm からダウンロード可能な次

の文献を参考にしてください。 
 
Model Updating using Operational Data（T. Lauwagie、J.Guggenberger、J.Strobbe、E.Dascotte）、 
発表：モーダル解析国際セミナー2010（ISMA）、2010 年 9 月 20-22 日、ルーべン(ベルギー) 
 
構造設計の最適化（Structural Design Optimization） 
 
不連続（離散）材料の最適化 
 
不連続材料（Discrete material）の最適化（DMO：Discrete Material Optimization）は、複合材料分布（lay-up）
を最適化することを目的とした、新たに追加されたツールです。DMO は利用可能な材料特性および方向成分

（角度）のセットから、最適な材料特性および方向成分を識別することができます。 
 
DMO 問題の解析は次のステップから成ります。 
 
 設計空間での FE モデル作成：最適化されるプレート要素タイプは、ET_LAYERED の幾何学特性を持っ

ていなければなりません。 
 
 設計空間での荷重および境界条件の適用 
 
 DMO パラメータを定義するために必要な要素セットの作成 
 
 DEFINE DMO PARAMETER コマンドを使用し、DMO パラメータを定義する。 
 
 DEFINE DMO OPTION コマンドを使用し、DMO オプションを定義する。 
 
 DEFINE DMO CBFILTER コマンド（オプション）を使用し、DMO 格子フィルタを定義する。 
 
 それらの形成方法とDiscrete Material Optimizationダイアログボックスのオープンは、メニューから、Tools 

> Discrete Material Optimization、あるいはコマンドの SET DMO および DMO SOLVE を使用します。 
 
DMO オプティマイザーは次の設計問題を解決することができます。 
 
最小静的コンプライアンス設計（Minimum Static Compliance Design）：最最小静的コンプライアンス設計は自

動的に選択されます。 
 
より詳細については、FEMtools 最適化ユーザーガイドの「Discrete Material Optimization（不連続材料の最適

化）」を参照してください。 
 
いくつかの例証が、..¥examples¥optimization¥dmo で利用可能です。 
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Discrete Material Optimization ダイアログボックス 
 
遺伝的アルゴリズム（Genetic Algorithm）による最適化 
 
遺伝的アルゴリズムは確率的な最適化方法です。自然淘汰と遺伝的な概念を使用し、反復的に最適化ソリュ

ーションを探索します。遺伝的アルゴリズムは、特定の状況（例えば、不連続な目的関数、離散型最大化変

数など）において、適用される別個の特質数を持っています。その遺伝的最適化問題の解決は次の 4 ステッ

プから成ります。 
 
 目的関数と拘束関数の値を計算するために評価スクリプトを作成します。 
 
 FEMtools データベース中に最適化パラメータを作成します。 
 
 FEMtools データベース中に目的関数と拘束関数を作成します。 
 
 メニューから、Tools > Genetic Optimization を選択し、また、 SET GA および GA SOLVE コマンドを

使用し、遺伝的オプティマイザーの形成し、実行します。 
 
FEMtools の遺伝的最適化ソルバーは次のタイプの最適化パラメータをサポートします。 
 
 連続的な実数値が最適化パラメータを評価します。 
 多くの特性を得るための分布パラメータ 
 
このオプティマイザーは次の最適化問題をサポートします。 
 
 単一の目的のための最適化問題。多重目的のための最適化問題を解決するには、評価スクリプト中の単

一の参照目的を組み合わせなければなりません。FEMtools 最適化ユーザーガイドの 3 章は、その詳細な

方法ついて説明します。 
 
 非拘束の最適化問題 
 
 拘束下の最適化問題。拘束は外部のペナルティ関数を使用し、オプティマイザーが実行不可能なポイン

トとして扱うことができます。これは実現不可能なソリューションがその問題の解決をスタートしない

ようにすることを暗示します。その拘束数に制限はありません。 
 
遺伝的アルゴリズムの使用方法に関する例証は、..¥examples¥optimization¥genetic で利用できます。 
より詳細については、FEMtools 最適化ユーザーガイドの「Genetic Algorithms（遺伝的アルゴリズム）」を参

照してください。 
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Genetic Algorithms ダイアログボックス 
 
不連続（離散）トポメトリーの最適化 
 
 トポメトリー・オプティマイザーは、最適化パラメータとして離散的プレート厚さ値をサポートします。 
 
 新しい SET TOPOMETRY コマンドが、トポメトリー最適化セッティングを指定するために付け加えら

れます。 
 
 トポメトリー最適化の例証に関するそれぞれのフォルダあります。 
 
 遺伝的アルゴリズムに関する例証は、..¥examples¥optimization¥topometry¥discrete で利用できます。 
 
トポロジーの最適化 
 
 ユーザー定義の拘束は、Topology Optimization（トポロジーの最適化）ダイアログボックスを使用して作

成することができます。 
 
 新しい SET TOPOLOGY コマンドがトポロジーの最適化セッティングを指定するために付け加えられ

ます。 
 
 トポロジーの最適化の例証に関するそれぞれのフォルダがあります。 
 
 トポロジーの最適化を使用し、最適な堅化（堅くする）位置を見つける方法の例証が加えられます。 
 ..¥examples¥optimization¥topology¥stiffener を参照してください。 
 

 
 

ユーザー・インターフェイス 
 
本章は、FEMtools メニュー・インターフェイスの変更について記述します。 
 
タブ配置モードのウィンドウ 
 
最大 MDI ウィンドウの調整機能のために、FEMtools メイン・ウィンドウにタブが加えられます。 
 
タブ配置モードは次の方法で選択することができます。 
 

 スタンダード・ツールバー上で Tabify ボタン（ ）を使用する。 

 17



 
 Window > Tabify メニュー・コマンドを使用する。 
 
 コンソールまたはコマンドのスクリプトから、TABIFY コマンドを使用する。 
 
 プログラム・スクリプトから、Ft_ArrangeWindows 関数を使用する。 
 
デフォルト・セッティングでは、タブがメイン・ウィンドウ上に表示されます。その他のセッティングは、

Edit > Settings > User Interface > Tabify Style メニューを使用して選択することができます。 
そして、上部の左ボタンあるいは底部の右ボタンを選択してください。 
 

 
 

FEMtools メイン・ウィンドウの新しいタブ・ウィンドウ配置 
 
エディタ・ウィンドウ 
 
いくつかの新しいショートカットはエディタ・ウィンドウで使用することが可能です。 
 
Ctrl+Enter  現在のラインをコピーする。 
Ctrl+Up   現在のラインが 1 ライン上に移動する。（それぞれのラインが交換されます。） 
Ctrl+Down  現在のラインが 1 ライン下に移動する。（それぞれのラインが交換されます。） 
 
それぞれのショートカットの詳細については、 Help > User Interface Reference > Shortcuts > Editor Windows 
Shortcuts を参照してください。 
 
また、 Edit > Go To メニュー・コマンドも新たに使用することができます。 
 

 
 

Go To Line ダイアログボックス 
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ドック化ダイアログボックスとパネル 
 
このバージョンはドック化ダイアログボックスおよびパネルを導入します。 
 
ドック化ダイアログボックス 
 
ドック化ダイアログボックスは、メイン・ウィンドウのエッジの 1 つに組み込む（「突き刺す」）ことが可

能な固定サイズのダイアログボックスです。それらは移動可能なダイアログボックスを同様に使用すること

ができます。メイン・ウィンドウのエッジに近傍にそのドック化ダイアログボックスをドラッグすると、そ

のドック化ダイアログボックスはメイン・ウィンドウのそれに引きつけられ、ドック化されます。 
 
ドック化ダイアログボックスの例として、エクスプローラ、Coordinate System Transformation（座標系変換）

ダイアログボックス（Database > Transform）、新しい Manual Pretest Analysis ダイアログボックスなどがあ

ります。 
 

 
 

座標系変換ダイアログボックス（ドック化例） 
 
パネル 
 
パネルは、サイズ変更することができるウィンドウにダイアログボックス、グラフィックス、テーブルなど

が構成されたウィンドウです。また、それぞれ構成はパネル・ウィンドウ内部でサイズ変更することができ

ます。パネルの例は、剛体特性エクストラクター・アドオン・ツールです。（Rigid Body Properties Extractorを
参照。） 
 
ドック化ダイアログボックスは、Unix 以外の Windows、Linux、Mac OS X 上で使用されます。 
 
新しいメニュー・コマンド 
 
次のメニュー・コマンドが、FEMtools のこのリリースに追加されました。 
 
Edit > Go To    エディタ中で特定ラインへ移動する。 
Database > Verify > Auto-DAC FEA Displacements 
     FEA-FEA オペレーション評価基準 (AutoDAC) 
Database > Verify > Auto-POC FEA Modes FEA-FEA 擬似直交性チェック(AutoPOC) 
Database > Verify > Auto-DAC Test Displacements 
     Test-Test オペレーション評価基準 (AutoDAC) 
Database > Verify > Auto-POC Test Modes Test-Test 擬似直交性チェック（Check (AutoPOC） 
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Database > FRFs    FRF オペレーション 
Database > FRFs > Trim   FRF バンドの下限/上限周波数の修正 
Database > FRFs > Swap   応答/加振 DOF の置換 
Database > FRFs > Scale   テスト FRF のスケーリング 
Database > Advanced > Add Noise  データにノイズ付加 
Pretest Analysis > Manual Pretest Analysis マニュアル・プリテスト解析の実行 
Correlation Analysis > Operational Phase Correlation (DPC) 
     オペレーション位相相関 (DPC)の計算 
Correlation Analysis > Pseudo-Orthogonality (POC) 
     擬似直交性(POC)の計算 
Optimization  > Discrete Material Optimization 不連続材料の最適化問題の解析 
Optimization  > Genetic Optimization  遺伝的最適化解析の実行 
Window > Tabify    タブ・モード・ウィンドウ表示 
 
変更済メニュー・コマンド 
 
Database > Normalize/Scale > Scale Test FRFs は、Database > FRFs > Scale Test FRFs に変わりました。 
 
プログラム/スクリプトのデバッグ 
 
新しいショートカットがプログラム/スクリプト中のステートメントをデバッグするために追加されました。 
 
Shift+F1   デバッグ・ステートメントを追加する。 
Shift+F2   デバッグ・ライン番号ステートメントを追加する。 
Shift+F3   デバッグ・テキスト・ステートメントを追加する。 
Shift+F4   デバッグ・ストア可変ステートメントを追加する。 
Shift+F5   デバッグ・ストップ・ステートメントを追加する。 
Shift+F6   現在のラインのデバッグ・ステートメントを削除する。 
Shift+F7   ブラケット間の表現を強調（ハイライト化）する。 
. 
それらのショートカットの詳細については、Help > User Interface Reference > Shortcuts > Editor Windows 
Shortcuts を参照してください。 
 

 
 

FEMtoolsコマンド 
 
FEMtools 3.5 コマンド言語はいくつかの新しいコマンドで拡張されました。また、既存のコマンドが増強さ

れました。そのすべての情報は、オンライン・ヘルプの「 FEMtools Command Reference」において参照する

ことができます。 
 
新しいコマンド 
 
この FEMtools リリースで利用可能な新しいコマンドを次に記述します。 
 
メッシュ・ツール 
 
CLEAR GENERATE  データベースからすべてのメッシュ生成テーブルを削除する。 
 
グラフィックス 
 
CURVE FRF PAIR  FRF カーブ・ペアを表示する。 
MATRIX POC   POC マトリックスをプロットする。 
 
プリテスト解析 
 
PRETEST   マニュアル・プリテスト解析を実行する。 
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相関分析 
 
EXAMINE DPC   変位位相相関（DPC）マトリックスを計算する。 
EXAMINE POC   擬似直交性チェック（POC）マトリックスを計算する。 
EXTRACT DPC   変位位相相関（DPC）マトリックスを抽出する。 
EXTRACT POC   擬似直交性チェック（POC）マトリックスを抽出する。 
 
最適化 
 
CLEAR DMO   DMO 情報をすべて削除します。 
DEFINE DMO CBFILTER  不連続材料の最適化のための新しい格子盤フィルタを追加する。 
DEFINE DMO OPTION  不連続材料の最適化に対する新しい材料/方向オプションを追加する。 
DEFINE DMO PARAMETER 不連続材料の最適化のための新しいパラメータを追加する。 
DMO SOLVE   不連続材料の最適化問題を解析する。 
GA SOLVE   遺伝的オプティマイザーを使用し、最適化問題を解析する。 
SET DMO   不連続材料の最適化セッティングを修正する。 
SET GA    遺伝的最適化セッティングを修正する。 
SET TOPOLOGY   トポロジーの最適化セッティングを修正する。 
SET トポメトリー   トポメトリーの最適化セッティングを修正する。 
 
モーダル・パラメータ・エクストラクター（MPE） 
 
MPE COMPUTE   FRF データからモーダル・パラメータを抽出する。 
 
ユーティリィティ - ユーザー・インターフェイス 
 
TABIFY タブ表示ウィンドウ（タイル） 
 
ユーティリィティ- セッティング 
 
SET CACHE コンパイルされたプログラム・スクリプト・キャッシュの On/Off スイ

ッチとして使用されます。ON の場合は、その後、スクリプトにキャッ

シュされたバージョンが使用され、OFF の場合は、その後、最初の.bas
スクリプトが使用されます。このコマンドはプログラム・スクリプト

開発者向けにサポートされます。 
 
修正されたコマンド 
 
この章は、FEMtools 3.5 のコマンドのシンタックス（構文）や補語などの変更点について記述します。 
 
CURVE MATRIX マトリックスは整数タイプになりました。 
CURVE X ... Y ... マトリックスは整数タイプになりました。 
DEFINE MREC マトリックスにセットを定義するための新しい補語 SET が追加されま

した。 
DEFINE OPTPARAM 新しい補語MRECは許容最適化パラメータ値を含むマトリックスを参

照付けます。 
EXAMINE DAC シンタックスが修正され、FE-FE、FE-TEST、TEST-TEST の相関性に使

用されます。 
EXAMINE DSF シンタックスを修正されました。 
EXAMINE EVO シンタックスが修正され、POC 解析は削除されました。（新しいコマ

ンド EXAMINE POC を参照してください。） 
EXAMINE MAC シンタックスが修正され、EXAMINE AUTOMAC が追加されました。 
EXAMINE MSF シンタックスを修正しされました。 
GENERATE CS 新しい補語 ALLWARNINGS が警告メッセージ数を制限するために使

用されます。このコマンドは単に表面ノードを考慮します。 
 
GENERATE EXTRUDE 新しい補語 NORMAL が正規表面の「押出し」のために使用されます。 
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MATRIX 「未定数（not-a-number）」はマトリクス表示から省略されます。 
MODIFY FRF FRF 上の周波数レンジを再定義し、加振と応答の DOF の交換、再サン

プリング、タイプの変更などための新しい補語が追加されました。 
REGROUP ANISO2D と ANISO3D の材料がサポートされ、ORTHO3D 材料が再編

成されました。 
RESPONSE FRF 補語の STEP ival が周波数ステップを指定するために追加されました。 
SET TUNE パラメータ推定が先頭文字の$指定のない場合にも対応できます。例え

ば、それは、$BAYESIAN の代わりの BAYESIAN などです。外部ソル

バーの内部が感度解析用の要素マトリックスを計算しなければならな

いかどうか明示するための新しい補語 SENSITIVITY が使用されます。

また、外部ソルバーを使用し、大規模な FE モデルのアップデート用の

セッティングを保存メモリで使用するために指定する新しい補語

LARGEMODEL が使用されます。 
 
削除されたコマンド 
 
この章では、FEMtools 3.5 の削除されたコマンドなどの変更について記述します。 
 
EXAMINE AUTOMAC このコマンドのシンタックスが修正され、EXAMINE MAC TYPE 

CROSS に変わりました。 
 

 
 

FEMtoolsスクリプト言語 
 
FEMtools 3.5 スクリプト言語には、いくつかの新しい関数が追加され、また既存の関数も強化されました。

より詳細については、オンライン・ヘルプの「FEMtools Script Reference」を参照してください。 
 
新しい関数 
 
下記はこのバージョンに追加された新しい関数です。 
 
_Debug デバッグメッセージを生成します。 
DateTimeBox 対話テンプレートにカレンダー目的で日付と時間の編集グボックス

を追加します。 
FClose FOpen 関数を使用してオープンされたファイルをクローズします。 
FFlush 出力バッファー中の不出力データのすべてをファイルに書きます。 
FOpen 読むか書くためのファイルをオープンします。 
Rewind ファイルの先頭に戻します。 
 
修正された演算および関数 
 
この章では、既存の FEMtools スクリプト関数の変更点について記述します。 
 
¥ Operator 引数はスカラーまたは配列を指定できます。 
Atan2 引数はスカラーまたは配列を指定できます。 
Complex 引数はスカラーまたは配列を指定できます。 
Mod Operator 引数はスカラーまたは配列を指定できます。 
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FEMtools API 
 
FEMtools 3.5 API はいくつかの新しい関数が追加され、また既存の関数が強化されました。より詳細について

は、オンライン・ヘルプの「FEMtools API Reference」を参照してください。 
 
新しいFEMtools API関数 
 
この章は、新たに追加された関数について記述します。 
 
データベースAPI関数 
 
Ft_PutFRF   既存の周波数応答関数（FRF）の定義を修正する。 
 
ユーザー・インターフェイスAPI関数 
 
Ft_Script    コンパイルされたプログラム・スクリプトを使用する。 
 
修正されたFEMtools API関数 
 
この章は、このリリースに FEMtools API 関数への変更について記述します。 
 
メッシュ・ツールAPI関数 
 
Ft_ExtrudeMesh   正規表面の「押出し」関数 
 
データベースAPI関数 
 
Ft_GetRShape 指定シェープリストの項目を修正する。 
Ft_GetShape 指定シェープリストの項目を修正する。 
Ft_PutShape 指定シェープリストの項目を修正する。データタイプの自動フィット、

入力座標系を指定するための新しいオプションなどの機能に使用され

ます。 
Ft_PutRShape 指定シェープリストの項目を修正する。 
Ft_ReadOP2Shape OES1 と OESX のデータ・ブロックのサポート機能 
 
解析API関数 
 
Ft_DefOptParam パラメータ値を含むマトリックス名を指定するための新しいオプショ

ン 
Ft_GetOptParam パラメータ値を含むマトリックス名を指定するための新しいオプショ

ン 
 
ユーザー・インターフェイスAPI関数 
 
Ft_ArrangeWindows 新しいタブ・モード（Tabify）の MDI ウィンドウにタイプを変更しま

す。 
Ft_GetWindowProp 新しい「タブ・モード（Tabified）」特性 
Ft_GetEditor 新しい「シグナリング（signaling）」特性 
Ft_SetEditor 新しい「シグナリング（signaling）」特性 
 
プロセス制御API関数 
 
Ft_Script    新しいアクションとして「exists」が追加されました。 
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新しいAPI環境変数 
 
スカラーとストリング 
 
console.colors.diagnosti  Ft_Report 「診断（diagnostic）」出力カラーの指定 
console.colors.debug  _debug コントロール出力カラーの指定 
layout.config   コンフィグレーション・エクスプローラのカスタマイズ用に使用 
layout.templates   コンフィグレーション・エクスプローラのカスタマイズ用に使用 
 
マトリックス 
 
pair.frf.error   ペア FRF 間の振幅差分 
pair.frf.sac   ペア FRF 間のシグネチャー保証基準 
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